T 2 I PRINTING SOLUTIONS

Network Guide

O

U

CONNECTIVITY INFORMATION



PREFACE

Every effort has been made to ensure that the information in this document is complete,
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of
errors beyond its control. The manufacturer also cannot guarantee that changes in software
and equipment made by other manufacturers and referred to in this guide will not affect
the applicability of the information in it. Mention of software products manufactured by
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:
http://www.okiprintingsolutions.com

07085901 Iss.02 Copyright © 2010 Oki Europe Ltd. All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.
Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Computer.

Other product names and brand names are registered trademarks or trademarks of their
proprietors.
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

WARNING!

A warning provides additional information which, if ignored, may
result in a risk of personal injury.

CAUTION!

A caution provides additional information which, if ignored, may
result in equipment malfunction or damage.
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NETWORK CONFIGURATION

INTRODUCTION

Your printer incorporates a fast 100BASE-TX/10BASE-T network interface. This guide
explains the functionality of the built in network interface. Access for interconnection is
provided via an interface panel at the rear of the machine.

This network interface supports IEEE802.2, IEEE8B02.3, Ethernet-l11 and SNAP, and can
detect those frame types automatically.

Also, the interface supports major protocols such as TCP/IP and IPX/SPX (NetWare).
This guide details the network interface specification and several software utilities.

You should set the emulation in the Printer Menu settings to Auto or PS before printing the
configuration map.

NOTE
This guide is written to cover a number of products and as such may contain
information about features that your product does not have installed or does

not support.

Operating system support varies between products. Please check with your
support website for latest information.

Not all utilities, features or protocols are supported by every operating
system. Please check with your User’s Guide and support website for latest
information.
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SPECIFICATION

ITEM SPECIFICATION

Frame Types IEEE 802.2
IEEE 802.3
Ethernet-11, SNAP, AUTO

Network Interface 100BASE-TX
10BASE-T

Network Protocols TCP/IP V4, V6

IEEE 802.1x

Network layer: ARP, RARP, IP, ICMP
Session layer: TCP, UDP

Application layer: LPR, FTP, TELNET, HTTP, HTTPS, IPP,
BOOTP, DHCP, SNMP v1, SNMP v3, DNS, DDNS, SMTP,
Port9100, POP3, SLP, WINS, Windows Rally, Bonjour

IPX/SPX (NetWare)

Remote printer mode (up to eight file servers and 32 queues)
Print server mode over IPX/SPX (up to eight print servers)
Encrypted password supported in print server mode
EtherTalk

NetBEUI

NetBIOS, WINS

LDAP

Kerberos

Windows Rally

SSL/TL

IPSec

Functions Self-diagnostic test printing
Banner supported
Monitoring and configuration by Web browser

Printer status notification by E-Mail

NOTE

Not all utilities, features or protocols are supported by every operating
system. Please check with your User’s Guide and support website for latest
information.

CONFIGURATION SETTINGS

Refer to your User Guide for details on how to print a configuration map. Alternatively, if
your printer is fitted with a test button (located on the network interface panel at the rear
of the machine); with the printer power switched on, press the test button for more than
three seconds and release. The self-diagnostic test results and configuration settings are
printed.

On the first page of the Network Information that is printed out, under the heading “General
Information” the MAC Address is given. For example:

MAC ADDRESS 00:80:87:84:E3:F1
The Ethernet address is therefore: 00:80:87:84:E3:F1
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CONFIGURATION UTILITIES

You can configure the network interface card (NIC) by using one of the following methods:

UTILITY

Quick Setup

FEATURES

Configure the NIC easily
and simply without
installing any software
packages into your
system. You can set the
following:

> Enable/disable TCP/IP,

NetWare, EtherTalk,
NetBEUI protocols.

> Set IP address, Subnet
Mask and Gateway for
TCP/IP manually or by
using DHCP.

> Set NetWare Mode and
create Queue/Print
Server/Printer objects.

> Zone name and Port
name for EtherTalk.

Admin
Manager

Configure the NIC in
detail.

SYSTEM REQUIREMENTS

Windows:

Windows 2000

Windows XP Home/Professional
Windows XP Professional x64 Edition
Windows Server 2003

Windows Server 2003 x64 Edition
Windows Server 2008

Windows Server 2008 x64 Edition
Windows Vista (32-bit & 64-bit)
Windows Server 2008R2

Windows 7 (32-bit & 64-bit)

(TCP/IP protocol or IPX/SPX protocol
should be installed).

Mac:
Mac OS X 10.2 or greater

You need to install Rosetta if using Mac OS
X 10.6

Web Browser

Configure the NIC and
printer by using a Web
browser such as
Microsoft Internet
browser or Mozilla

Microsoft Internet Explorer or similar.

card can be controlled
using third-party vendor
developed SNMP
application.

Firefox.
Telnet Configure the NIC using Third-party vendor developed TELNET
TELNET. client package.
A TELNET Application is standard in
Windows/UNIX/Linux.
SNMP The printer and network Third-party vendor developed SNMP

application.
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USING QUICK SETUP

Quick Setup utility allows you to configure the network interface easily and simply without
installing any software packages.

You can configure the following:

> Enable/disable TCP/IP, NetWare, EtherTalk, NetBEUI protocols.

> Set IP address, Subnet Mask and Gateway for TCP/IP manually or by using DHCP.
> Set NetWare mode and create Queue/Print Server/Printer objects.

> Zone name and Port name for EtherTalk.

Configuration requires a PC with a supported Windows operating system (see above),
running TCP/IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to the network with TCP/IP or
IPX/SPX.

This utility must be used on a PC that is located on the same segment as the printer.

1. Insert the CD-ROM/DVD-ROM into the CD-ROM/DVD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click \setup.exe (in the root
directory) on the CD-ROM/DVD-ROM.

2. If you agree to the User License Agreement, click Next.

3. Select the appropriate language and follow the on-screen instructions.

4. Navigate to and select Network Card Setup.

5. Select the “Install” link.

6. Select your language.

7. Select Oki Device Quick Setup and follow the on-screen instructions.

8. Verify that the settings are correct, then click Execute.
The new settings are transmitted to the network card but it still operates with pre-
transmission settings.

9. Click Finish to validate the new settings.

10. Switch the printer off for 15 seconds and on again.
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USING ADMINMANAGER

NOTE

Not all utilities, features or protocols are supported by every operating
system. Please check with your User’s Guide and support website for latest
information.

AdminManager is a powerful Microsoft Windows-based utility to configure all network
interface functions easily and intuitively via a graphical user interface.

Configuration requires a PC with a supported Windows operating system (see page 8)
running TCP/IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to the network with TCP/IP or
IPX/SPX and must be used on a PC that is located on the same segment as the printer.

INSTALLATION

1.

N o g AMON

Insert the CD-ROM/DVD-ROM into the CD-ROM/DVD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click \autorun.exe (in the root
directory) on the CD-ROM/DVD-ROM.

Select the appropriate language.

Navigate to and select Network Card Setup.
Select the “Install” link.

Select your language.

Select Oki Device Standard Setup.

If you want to install AdminManager on to your local drive, select Install and
Execute. Otherwise, select Execute from CD-ROM/DVD-ROM. Follow the on-
screen instructions.

To run AdminManager, check Yes for Do you wish to execute AdminManager?
and click Finish. Otherwise check No and click Finish.
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INTERFACE

Select Start > Programs > OKi Setup Utility > Admin Manager.
A BAEI IR

<] »
1 O Diic s are 15und in e nedesrk.

MENU ITEM FUNCTION
File Search Search printers in your network and list all printers.
Status Printer Status Current printer status is displayed:

&

T

System Status | Displays current NIC configuration. 2 & ¥

Configuration data can be saved as
log file. S
Network Fimmware Version - 04.50
e
b 1?9 ?‘fl ::‘ :lﬂw.l"\)l
o
s ey 000
\I'_\:llfrse:msol? oonoo
on'.'mu:ou(amnnrmam
List of Displays current NIC configuration. L
Configuration Configuration data can be saved as e Terte i sats
Items log file. i
Setup Oki Device Configure the network interface (NIC).

Setup

Setup by HTTP | Launch the default browser in your environment to access
the selected printer’s web page.

Setup by Launch TELNET application in your environment to access
TELNET the selected printer’'s TELNET port.
Setup Create Create a NetWare queue.
NetWare Note: Only visible when using Netware.
Queue
Delete Delete NetWare object.
Netware Note: Only visible when using Netware.
Object
Reset Reset the selected network interface card.
Test Print Print self-diagnostic test pages.
IP Address Set static IP address of network interface card manually.
Setup
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DEVICE SETUP

NOTE
Not all utilities, features or protocols are supported by every product. Please
check with your User’s Guide and support website for latest information.

Device Setup allows you to configure the network interface. Type the root password
(default value is the last 6 characters of the MAC address) to configure. Remember that the
root password is case sensitive. If the MAC address contains any alpha characters, type
them as upper case. Device Setup contains details for the following selectable tabs:

> General > SNMP > IEEE 802.1x
> TCP/IP > POP > NetWare

> SMTP > Ethertalk > Maintenance
> NetBEUI/NetBIOS = SSL/TLS > SNMP

> LDAP > Kerberos > SNTP

> E-Mail(Send) > E-Mail(Receive)

The following section explains each tab’s functionality. Depending on your printer, some
items in the following explanation may not be displayed.

General Tab

V.OKl Device Setup @

General | TRAP | Netrare | EtherTalk | NetBEUI| BhMP | E-MailiSend) | E-traic 4 | »

admin Passward Im

Change. |

Initialize; | Apply | Cancal |

This allows you to set or change the root password used for Admin Manager, TELNET and
FTP.

Password Setup m
Old password I

Mew password I
Canfirm new passward I
(014 I Cancel |

EXPLANATION

Change root You can set/change the root password for AdminManager, TELNET
password and FTP.
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TCP/IP Tab

General TGP | Netiare | EtherTalk | NetBEUI | ShiP | E-Mailigend) | snte | 4] »
I™ Use TCPIP Protocal
I~ Use DHCRBOOTP

I~ Use IPv6

IP Address 169 !'_‘ ,_‘_ l___
Subnet Mask 255 l_ ,T lT
Auto Discovery.. I DME Server...

Default Gateway ,T l_ ,— !_
|
|

WINS Eerver...

This allows you to configure TCP/IP related items.

ITEM EXPLANATION

Use TCP/IP Set TCP/IP protocol as enabled/disabled.
Protocol

Use DHCP/BOOTP Check this item if IP address, subnet
mask, default gateway and IP
addresses for DNS primary server and
secondary servers are retrieved from
the DHCP or BOOTP server. Otherwise,

uncheck.
Use IPv6 Enables IPv6.
IP Address Set the IP address of the selected

network interface card.

Subnet Mask Set the subnet mask of the selected
network interface card.

Default Gateway Set the default gateway of the selected
network interface card.

Auto Discovery | Configure items related to Network PnP

Use to select Network PnP and Bonjour, and to 5 Use Bonvue
set device name. Docetarra

fora c5a00- 547515

DNS Server... Set IP addresses for DNS primary and g %]
= =
secondary servers. | D RS —
| St e & [v o
T e DONS
=] G|
Windows Use WSD Print Check to enable/disable WSD Print.
Rally... Use LLTD Check to enable/disable LLTD for
network map function on windows Vista
or later.
WINS Server Set IP addresses for WINS primary
and secondary servers and to enter s [e 0 i e o
SCOpe ID. Becordan Serer [0 o Jo [
toe O ’7
s |
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NetWare Tab

This is where you can configure NetWare related items.

ITEM EXPLANATION

Use NetWare Protocol

Set NetWare protocol as enabled/disabled.

Use IPX Protocol / Use TCP/IP Protocol

Set protocol to use.

Print Server Name

Set Print Server name.

Frame Type

Set primary NetWare frame type.

Operation Mode

Set NetWare mode.

Check box beside Bindery Setup

Check if you want to use the Bindery mode
and Bindery Setup button becomes available.
If it is unchecked, the button is greyed out.

Bindery Setup

Configure items f o Gk
related to
Bindery mode.

Fil Béovee 13 B0 Eonrbcind

1
In this dialogue 2 2
box, the following K

items can be Pastmarn | —

configured: e [ e
e O

Password. Set password for Print

Server.

Job Polling Time. Set print job polling

interval in seconds.

NDS Setup

Set NDS tree and

| 105 bt Sty 5% |
context where HoS Te
Print Server was P
created. —
RPRINTER Setup Available if G 0|
you select Gmeeal| TCPP Nt | D Talk | et | ShdP | C-asenc) | sy 4[]
RPRINTER e
- & Ui 1P Protocol ™ Ve TCPAP Protacel
mode I-r] Frink Sarver Name 0 CRO0AL-PS
Operation FiamaTron Py 3
Mode. Coraten Nt

 PSERVER Mode ~ RPRINTER W

Privtes Hame [oka-casn0 cBIEALFR

| | camel |

By selecting the

| Detait tor EFRITER e
RPRINTER P e b cormeited
button, this is : s:
displayed: ; 7l
Here you can 9 of
specify i)rlnth. . Tone T ey
servers to whic

C ] oo

the printer can
be connected.

Set duration from the
last data’s arrival to
freeing of the port in
seconds.

Time Out

Printer Name

Set the NetWare printer object name.
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EtherTalk Tab

O Device Setup LZJ-E-]
General | TCRIP | Netriara EurTalk | etgiEw | St | E-mangend) | E-maiig 4] »
% Ui EltwerTalk Proloeod
Printir Naene [ergo
Zone Name -
I A | Cancel [

This allows you to configure EtherTalk related items.

ITEM EXPLANATION

Use EtherTalk Protocol Set EtherTalk protocol to enabled/disabled.

Printer Name Set EtherTalk Printer object name.

Zone Name Set the zone name to which the printer belongs.
NetBEUI/NetBIOS Tab

U
OKI Device Setup

General | TOPAP | Netware | EtnerTalk MEtBEUI | snmP | E-mailsend) | E-mail 4| »

¥ Use NetBEUI Protocol

Shart Printer Mame |cssUU-CEUEA4

Wiarkgraup |Prm|5emer

Comment IEthemEtEloard OKILAN 84502

Initialize | Aply | Cancel |

This allows you to configure NetBEUI/NetBIOS related items.

ITEM EXPLANATION

Use NetBEUI Protocol Set NetBEUI protocol to enabled/disabled.

Use NetBIOS over TCP Set NetBIOS over TCP to enabled/disabled.

Short Printer Name Set a name for the printer.

Workgroup Set a work group name to which the printer belongs.
Comment Set the comments for the printer (optional).
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SNMP Tab

This allows you to configure SNMP related items.

.-
0Kl Device Setup ma

General | TORIF | Netware | EtherTalk | NetBEUI SMUP | E-traiSeng) | a4 ] »

v Use SNMP Senice

[sHMPys + smPyt B

SNMPY! Settings | SNMPY3 Settings |

MIE-II P

SysContact I

Syshame |0K\VCESUUVCBUEA4

SysLocation |

Printer Trap Setup. |

Tnitalize: | | cancel |

ITEM EXPLANATION

Use SNMP Service ENABLE or DISABLE the SNMP protocol.
SNMPV1+V3 Select from the drop-down box which (or both) of these to use.
SNMPV1 Settings SNMP Read & Write Enables these passwords to be changed.
Community.
SNMPV3 Settings Enables Authorisation and Privacy (Encryption) setup to be done.
SysContact Set SysContact (printer manager) name.
SysName Set SysName (printer model name).
SysLocation Set SyslLocation (the location where the printer is installed).
Default TTL Set TTL (Time To Live) value.
Printer Trap Setup... By selecting the button, the following s =g
dialogue box is displayed: e |
In the dialogue box, the following we [T [ [ [ o |
items can be configured: et o [0 [ o o | o]
TCR# [o [o o [0 Distadl |
TCR M {0 o o | o) Dietant. |
TCR# o o o if o) Dietast. |
L [ooooose [ oowoownds ows. |
=1 i
Printer Trap This community name is assigned to
Community Name outgoing printer status traps such as off-

line, paper out, etc.

TCP#1-5 Set the IP addresses to which a Trap packet
will be sent. You can set up to five IP
addresses, with the following details:
Printer Reboot

Receive lllegal

On-Line

Off-Line

Paper Out

Paper Jam

Cover Open

Printer Error (any error)
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ITEM EXPLANATION

IPX Set node address and network address to
which a Trap packet will be sent.

By selecting the button, the following
dialogue box is displayed:

In the dialogue box, the following items can
be configured:

Printer Reboot

Receive lllegal

On-Line

Off-Line

Paper Out

Paper Jam

Cover Open

Printer Error (any error)

E-Mail (Send) Tab
This allows you to configure SMTP related items.
OKI Device Setup Lﬂm

Genersl | TCRIP | Netware | EtherTalk | WetBEUI | Shp E-MalliSand) | E-aiig 4 | ¥

I~ Use SMTP Transmit

SMTP Gerver Mama I

Frinter E-mail Address I

1 2 | 3 | 4 5 |

’—Desmalun Addri

Altach Info.. | Comment.. |

Althentication. | Others. |

Initialize | Apply: | Cancel |

ITEM EXPLANATION

Use SMTP Transmit Check to enable SMTP
SMTP Server Name Enter name of the SMTP server
Printer E-Mail Address Enter the printers e-mail address

Destination Address 1 - 5 | Set the following parameters:

Destination Address Set E-Mail address to which email
should be sent.

Notify Mode Select PERIOD or EVENT

When PERIOD is selected:

Check time Used to set the interval at which the
selected events are checked. An e-
mail will be sent at the specified
interval for each event selected.

Period mode Set ON/OFF for the events listed.

When EVENT is selected:
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EXPLANATION

Event Mode Select:

ENABLE (ON), DISABLE (OFF) or
IMMEDIATE (NOWAIT) for the listed
events. If ENABLE (ON) is selected,
the check interval is settable in
hours and intervals of 15 mins.

Attach Info... Select whichever information is to be included in the e-mail.

Comment... Set up to four lines of text to be included with the e-mail as
comments.

Authentication... Used to set the following security information:
SMTP Encryption Select required option from the
Algorithm drop-down menu. Select from:

None, SMTPS, STARTTLS

SMTP Authentication Check to Enable SMTP

Method Authentication.
User ID Set the User ID for Authentication
User Password Set the User Password for

Authentication.

Others... Set the following:
SMTP Port Number Set the SMTP port number (default
is 25)
Reply to address Set the E-mail address used for the

Reply to field in the mail header.

E-mail (Receive) Tab

OKI Device Setup B[]

TGPIP | Metware | EtherTalk | NetBEU! | SNMP | E-aiGeny) EMaiRecsive) | 4] v

- POP Receive

[~ Use POF Receive

POP3 Server l—
POP3 Server User ID ,—
POP3 Server Password ,—

~ EMTP Recey

[~ Use SMTF Receive

Domain Filter.

Initialize | Anply | Cancel |

Some printers support an email reception function (SMTP/POP3) allowing the printer to
print PDF and text files attached to emails. If this tab is not displayed, your printer does
not support the function.

ITEM COMMENTS

Use POP Receive Enable/disable receiving E-Mail via POP3.
POP3 Server Set the IP address or host name of the POP3 server.
POP3 Server UserID Set User ID for POP3 server.

POP3 Server Password | Set a password for the POP3 server.
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ITEM COMMENTS

POP Detail... Set the following:
Use APOP Select if you want to use APOP.
POP3 Port Set the port number for APOP (default is
Number 110).
Mail Polling Set interval to retrieve E-Mail(s) from the
Time POP3 server. Selectable values, OFF, 1min,

5min (default), 10min, 30 min, 60 min.

POP Encryption | Select required option from the drop-down

Algorithm menu. Select from: None, POP3S,
STARTTLS
Use SMTP Receive Enable/disable SMTP receive.
Domain Filter... Set the following:
Use Domain Enable/disable domain filtering.
Filter
Filter Policy Select ACCEPT (the default) or DENY.
Domain Filter Define up to five domain filters.
SNTP Tab
IFOI(I Device Setup LZ_]W
NEtBEUI | ShMP | E-wailiSen | E-vailReceive) SNTP | maintenance | ssuTLs <[ b |
I~ Use SNTP
TP Server 1 Address I
NTP Server 2 Address I
Adjust Intareal m

Local Time Zone

;t o o -

[~ Daylight Saving

Initialize | Apply | Cancel

In this Tab, you can configure SNTP related items.

ITEM COMMENTS

Use SNTP Enable/disable SNTP (Simple Network Time Protocol).

NTP Server 1 Address Set the IP address or host name for NTP Server 1.

NTP Server 2 Address Set the IP address or host name for NTP Server 2.

Adjust Interval Set the interval for sending time update requests to the
server. Select 1 hour (the default), 12 hours or 24 hours.

Local Time Zone Set the local time zone from -12:00 to +13:00. Minute interval
is selectable from 00 (the default), 15, 30 or 45.

Daylight Saving When this is selected, one hour is added to the local time.
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Maintenance Tab

I’OKI Device Setup mw

NEtBEUI | SNMP | E-MailSend) | E-MailRecetie) | HTP Maintenance | ssLLs 4] ¥

LAN Seale |NOHMAL L!

IP Filter Setup. |

Service |

Initialize | Apply | Cancel |

ITEM COMMENTS

LAN Scale Select NORMAL (the default) or SMALL.

Note: For small scale networks (with no routing), choose the
SMALL setting. For more complex networks choose NORMAL.

IP Filter Setup... The following items can be configured:
Use IP Flliter Enable/disable IP Filtering. Default is
disabled.

Admin IP Address Enter the printer’s IP Address.

IP Address Range Set up to 10 IP Filter address ranges: IP
Fllter Range 1 through IIP Filter Range 10.

Printing Enable/disable printing of the specified IP
address range. Default is disabled.

Configuration Enable/disable changing IP address ranges.
Default is disabled.

Service... The following features can be selected by clicking their check
box.

Use TCP/IP Protocol
Use NetBEUI Protocol
Use NetWare Protocol
Use EtherTalk Protocol
Use FTP Service

Use Telnet Service
Use Web Service

Use SNMP Service
Use POP3 Protocol
Use SNTP

Use IPP Service

Use SNMTP

Use SNMP Service
Use SMTP Transmit
Use encrypted communication for configuration data
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SSL/TLS Tab

I’OKI Device Setup mw

SHMP | E-MaliSend) | E-Mal(Receve) | SNTP | Mantenance S3LTLS | iEEE80: 4]

Encryption Strongth Standard x

- Create Getificate

& Gelreighed Certificate Create Cerlificate...

 Chsigned Cerificate

Initialize | Apply | Cancel |

ITEM COMMENTS

Encryption Strength/ Set the strength of encryption:

Cipher Level Strong = highest security, slowest speed
Standard = medium security, medium speed
Weak = least security, fastest speed

Self-signed Certificate For IPP encryption within an organisation’s internal network
(intranet).

Create Certificate... When Self-signed Certificate is selected, the following items
are configured:

Common Name The printer’s IP Address appears here.

Organisation Enter the name of your organization.

Organisation Unit | Optional. Allows you to enter a
subdivision or department name.

Locality Enter the name of the city where the
organization is located.

State/Province Enter the state or province where the
organisation is located.

Country/Region Enter the country or region where the
organisation is located.

Key Exchange Select RSA (the default) or

Method Diffie-Hellman(DSS).

Key size Select 512, 1024 (the default), or 2048
bits.

Term of Validity Enter a starting and ending date (month/
date/year) for which the certificate is
valid.
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ITEM COMMENTS

CA-signed Certificate... Used for web encryption to provide security when printing
over the internet. Requires an outside certification service
which must be purchased separately.

Create Certificate... When CA-signed Certificate is selected, the following items are
configured:
Common Name The printer’s IP Address appears here.
Organisation Enter the name of your organisation.

Organisation Unit | Optional. Allows you to enter a
subdivision or department name.

Locality Enter the name of the city where the
organization is located.

State/Province Enter the state or province where the
organisation is located.

Country/Region Enter the country or region where the
organisation is located.

Key Exchange Select RSA (the default) or
Method Diffie-Hellman(DSS).
Key size Select 1024 (the default) or 2048 bits.
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IEEE802.1X Tab

r(jlii'l)evice Setup L"’_Im

-Mail(Ser -Mail{Receive aintenance
E-Mail(Send) | E-Mail{Recei SNTP | Maint S5UTLS |EEEBDZ.1H AL

[~ Use I[EEEBDZ.1%

EAP Type [Eap-TLs -

EAP User I

[~ Use SELTLS Certificate

v Ruthenticate Server

Certificate... |

Initialize | Anply | Cancel |

ITEM COMMENTS

Use IEEE802.1X Enable/disable.
EAP Type The following Extensible Authentication Protocols can be
configured:
EAP-TLS Selects Extensible Authentication Protocol
- TLS.
PEAP Selects Protected Extensible
Authentication Protocol - (includes
Password).
EAP User Enter EAP User name.
EAP Password Enter EAP password.
Use SSL/TLS Enable SSL/TLS certification.
Certificate
Authenticate server Enable Server Authentication.
Certificate Client certificate File: (User can specify).
Password: (User can specify).
Options to Import, Delete, View.
CA certificate File: (User can specify).
Password: (User can specify).
Options to Import, Delete, View.
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LDAP

OKI Device Setup Bx|
E-Mail(Receive) | SNTP | Maintenance | SSUTLS | IEEEBD2.1X Kerberos | 4| ¥
LDAP Server [
LDARP Port Mumber 389
LDAP Timeout [ 2
Maximum Entries 100
Authentication Method |An0nym0us Ll

Authentication User ID |

Authentication User Password |

Encryption Algarithm |N0ne _v_J

Search Filter... I

Initialize | Apply | Cancel |

ITEM COMPONENTS

LDAP Server Enter LDAP Sever name.

LDAP Port Number Enter LDAP port number (default is 389).
LDAP Timeout Set LDAP Timeout (default is 30).
Maximum Entries Set Maximum entries (default is 100).

Authentication Method | Select authentication method from the drop-down menu.
Anonymous (default), Simple, Digest-MDS, Secure Protocol.

Authentication User ID | Enter User ID.

Authentication User Enter user password.
Password
Encryption Algorithm Select encryption algorithm from the drop-down menu. Select

from: None (default), LDAPS, STARTTLS

Search Filter... Search root Search root.
Attribute Namel: cn
Name2: sn

Name3: givenName
Mail Address: mail

Additional Filter Enter additional detail (optional).
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Kerberos

E-Mail(Receive) | SNTP | Maintenance | SSUTLS | IEEE802.1X | LDAP

Domain |

Initialize | Apply | Cancel

Domain Enter Domain.

IP ADDRESS SETUP

If you only use TCP/IP and the printer has not yet been configured, occasionally it may not
be displayed on AdminManager. You can configure the IP address of the printer by this

function.
1. Select IP Address Setup from the Setup menu.
2. Set Ethernet Address and IP Address then select OK.

Ethemet Address I 0 I 50 I a7 I 74 I 57 I 23

IP Address WWIT'T
Ok | Cancel I

The Ethernet Address (MAC address) is displayed during the self-diagnostic test.

OPTION MENU
In the Option menu, the following item can be selected:

ITEM EXPLANATION

Use TCP/IP If this item is selected, AdminManager uses TCP/IP protocol to
Protocol search/configure network interface cards.

Use IPX/SPX If this item is selected, AdminManager uses IPX/SPX protocol to
Protocol search/configure network interface cards.
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ITEM EXPLANATION

Environment TCP/IP Tab o)
Setup Set broadcast addresses that are used to
search printers using the TCP/IP protocol.
If Use TCP/IP protocol is unchecked, the ot
search will not be carried out using TCP/IP.
|
= ] tosint |
NetWare Tab =y — i |
Terwr Mevwes | Sraer | Tivmend |
Set network addresses that are used to < e s
search printers via NetWare protocol. If el
there any many NetWare file servers on ! o —
your network, specify the network address
to which the network card belongs. If Use
NetWare protocolis unchecked, the search
will not be carried out using NetWare, but if L] o
Auto Search is selected, AdminManager
will search all networks that AdminManager can detect.
SNMP Tab = — ]
Obtain the printer name via SNMP - Select bl o s
Enter Community name. e
| L S|
Add and Delete -
C= o
TimeOut Tab T — o
Search Every: Set response waiting time ——
from a network card in seconds. S e —
Time Out: Set time out between
AdminManager and the network interface e —
card in seconds. mon ==
Retry: Set how many times the retry will e o
be carried out between AdminManager and
the network interface card.

HELP MENU

In the Help menu, About is available as well as revision information for AdminManager.
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USING A WEB BROWSER

If the printer is connected to the network using TCP/IP, its settings and the printer menu
settings can be configured using a Web browser. Refer to the relevant manuals for details
of how to launch and use the browser. Refer also to “Web browser” on page 56 for
instructions on how to prevent your browser caching the printer web pages.

DEFAULT USER NAME AND PASSWORD

To apply configuration changes using a Web browser, you will be prompted for a username
and password. The username is root and the default password is aaaaaa.

NOTE

To apply configuration changes using AdminManager, the username is root
and the default password is the last six characters of the Ethernet (MAC)
address (any alpha characters must be in upper case).

The root password can be changed to allow you to configure the printer by using a Web
browser/TELNET/AdminManager. To change the root password, select Password
Configuration in the Maintenance tab and follow the on-screen instructions.

ADJUSTING PRINTER SETTINGS

The network addresses used in this manual are shown as examples only. Network
addresses used in your installation must be generated from your own network.

1. Configure the IP Address, Subnet Mask and Gateway for the network card. Launch
the Web browser, enter the IP Address of the network interface card in Address
(Location/Position) and press the Enter key.

The Printer Status screen is displayed.

2. Select a tab and items to be changed in the left frame. You need to log in as “root”
to be able to configure all items. Non-root users cannot configure all items.

Network configuration > 27



USING TELNET

Please ensure a valid IP address for your network environment is
used. Use of an incorrect IP address can cause serious problems on
your network.

EXAMPLE TELNET CONFIGURATION

TELNET requires the print server to have a valid IP address configured. If the NIC already
has an IP address configured, skip steps 1 to 3 below.

NOTE
The method of configuring commands may differ between workstations. Refer
to the workstation’s manual.

1. Use the PING command to confirm the connection with the network card.
Example
For IP address 172.168.20.127:
PING 172.168.20.127

If there is no reply, there is a problem with the configuration of the IP address (the
IP address has been already set manually or by the DHCP/RARP server), or with the
network. Reset the network interface card settings to the default and try to set a
temporary IP address. If you still have the problem after resetting the network
interface card, consult the network manager.

2. Enable TELNET protocol.
3. Login to the network card using TELNET.

NOTE
The default username is root and the default password is the last six
characters of the MAC address (any alpha characters must be in upper case).

Example

For IP address 172.168.20.127

TELNET 172.168.20.127

You should see a sequence similar to the following example:

Trying 172.168.20.127

Connected to 172.168.20.127

Escape character is “~]”.
EthernetBoard OkiLAN PRINTER".
login: root

“root” user needs password to login.
password:

User “root” logged in.

No. MENU (level.1l)

1:Status / Information
2:Printer Config
3:Network Config
4:Security Config
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5:Maintenance
99:Exit setup
Please select (1-99)7?

4. Enter the number of the item to be changed.
The details window for that item displays.

5. When the configuration is complete, select Exit Setup to save your change. To exit
without saving your modification, select Quit.

6. Turn the printer off and on again.

NOTE
The network card continues to use pre-transmission settings until the printer
is turned off and back on again.

UsSING SNMP

NOTE
Not all utilities, features or protocols are supported by every product. Please
check with your User’s Guide and support website for latest information.

The machine and network card can be managed via a standard SNMP management station.
The network card supports SNMPv1, MIB-I1, Oki Data Private MIB and SNMP V3. To enable
correct management from an SNMP management station, the Oki Data Private MIB needs
to be added to that management station. Please refer to the SNMP manager documentation
for information on adding MIBs to SNMP management stations.

NOTE

The Oki Data Private MIB file can be found in the MIB folder on the CD-ROM/
DVD-ROM or the support website. Please refer to the readme file for further
information.

The printer’s trap address can be set in five places using TCP/IP and in one place with IPX.

Printer trap settings can be made with TELNET and a Web browser.
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MANAGEMENT UTILITY — PRINTSUPERVISION (WINDOWS ONLY)

NOTE
= Not all utilities, features or protocols are supported by every product.
Please check with your support website for latest information.

> For full details of how to install and use PrintSuperVision (v3.6), please
refer to the PrintSuperVision Configuration Guide, which is available on
the support website.

PrintSuperVision is a web-based application for managing printing devices connected to a
network. It consists of two parts:

> A web application based on Microsoft web server (Internet Information Server, 1S
or Personal WEB Server, PWS), that provides the user interface.

> A monitoring program (PrintSuperVisor) that runs all the time, collecting data and
saving it in a database for statistical reports and sending E-Mail alerts based on the
saved configuration.

PrintSuperVision requires the .NET environment to be installed on the PC on which it runs.
The supplied installer will install this if necessary.

PrintSuperVision’s main functions are:

Maintaining the list of printing devices and organising them in logical groups.
Initially discovering and configuring printers connected to the network.

Locating printers visually on maps.

Monitoring devices over time and saving data for statistical reports.

Sending email alerts when events occur that affects the functionality of printers.
Statistical reports about usage of printers.

Tracking maintenance data related to printers.

Identifying part numbers of consumable items for use with your printer.

Integrating with Oki Data’s on-line web support (for US and Canada).

v VvV VvV vV VvV VvV vV VvV VvV V

PrintSuperVision can even manage printers on another network provided a copy of
PrintSuperVision is also running on that network.

SYSTEM REQUIREMENT
Refer to the ReadMe files on the CD-ROM/DVD-ROM for details.

Supported Browsers

The PrintSuperVision application can be accessed from most Windows, Macintosh, Unix,
and Linux desktops.

PrintSuperVision works best when used with Internet Explorer.

Supported Printers

PrintSuperVision provides general management information for printers connected to the
network. For Oki printers, additional details, reports and added features are available.

While the printer properties are displayed in PrintSuperVision, only a few of the printer
settings can be set. For setting any other printer settings, a hyperlink to the printer’s web
page is provided in PrintSuperVision.
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INSTALLING PRINT SUPERVISION
This section describes installing Print SuperVision from the supplied CD-ROM/DVD-ROM.

NOTE
Some Operating Systems require administrator privileges in order to make
changes.

1. Insert the CD-ROM/DVD-ROM into the CD-ROM/DVD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click \setup.exe on the CD-ROM/
DVD-ROM.

Select Software Utilities.
Select Install PrintSuperVision.

When installation ends, the Setup complete screen is displayed. Click Finish.

o kr W N

Now you should select: Start > Programs > PrintSuperVision >
PrintSuperVision or double-click the PrintSuperVision icon on the desktop for
the PrintSuperVision server.

6. For PrintSuperVision client, access http://server IP address or host name/
PrintSuperVision from the Web browser. If you change the port number you should
add port number. Example: http://192.168.20.127/PrintSuperVision:8080.

7. PrintSuperVision has an on-line help facility.

UNINSTALLATION

To uninstall PrintSuperVision, either:

Select Start=Programs=>PrintSuperVision=Uninstall PrintSuperVision,
or...

From Control Panel, select Add/Remove Programs, select PrintSuperVision from the
index window and click Add/Remove.

When the uninstallation is completed, close Add/Remove Programs.

In some cases, an empty Okidata/PrintSuperVision/ directory may be left behind.
Delete the directory manually.

OKI LPR PRINTING UTILITY (WINDOWS ONLY)

NOTE
Not all utilities, features or protocols are supported by every product. Please
check with your User’s Guide and support website for latest information.

Oki LPR is a utility that allows printing data to printers connected to the network via TCP/
IP. It is an alternative method of connecting printers instead of using the Microsoft TCP/IP
port; however, the Oki LPR utility offers some additional and very useful features:

> Displays printer status - print job status can be viewed, paused or cancelled.

> Download files directly to the printer - send PRN or Postscript files directly to
the printer.

> Redirect print jobs - send print jobs to other printers if the original printer is busy
or has an error.

> Multicast printing - send the same print job to many printers simultaneouslyl.

1. The printers all have to be the same model.
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SYSTEM REQUIREMENT

Operating Systems with TCP/IP support and OKi printers that support TCP/IP.

INSTALLING THE OKI LPR UTILITY

@ N e 0

10.

11.

12.

13.
14.
15.
16.

17.

NOTE
Some Operating Systems require administrator privileges in order to make
changes.

Insert the CD-ROM/DVD-ROM into the CD-ROM/DVD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click setup.exe on the CD-ROM/
DVD-ROM.

Select the appropriate setup language and click 1 agree to accept the terms of the
Software Licence Agreement.

Select Software Utilities > Install Oki LPR utility.

In the Choose Setup Language dialog, select the appopriate language and click
OK.

The OKi LPR utility is displayed.

Click Next.

Click Yes to accept the Software Licence Agreement.

Verify Destination Folder and Spool Folder and click Next.

Check Register in Startup if you want automatic startup as Windows boots up.
Check Launch as minimized if you want to startup in the Icon state and click
Next.

Verify the program folder name and click Next.
The installation starts.

When the installation ends, the Setup complete screen is displayed. Check Yes, I
want to launch Oki LPR Utility now and click Finish.

Check Yes, I want to view the ReadMe File if you want to read Readme.
The OKILPR utility will start.

You may be asked whether it is OK to change write permissions for the spool
directory. Click Yes to allow the utility to be correctly installed.

Select Remote Print > Add Printer.
Click Discover... to search for the IP address of a suitable printer on your network.
Highlight the printer you will use and click OK.

If your printer is not discovered, click Cancel and you can type the IP address
directly at IP Address:.

Click OK. A machine is added to the main window.

Refer to the On-line Help for information on how to use the utility.
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UNINSTALLATION
1. To exit the Oki LPR Utility, select File > Exit.

2. Select Start > Programs > Okidata > OkiLPR Utility > Uninstall OkiLPR
Utility.

You may find this under Start > All Programs in Windows XP.
3. Click Yes when the “Confirm File Deletion” dialog is displayed.
Deletion of the OkKILPR utility starts.

4. When the deletion has finished, the Uninstall Complete screen is displayed. Click
OK.

If a file that has been added after installation exists in the folder to install the OkiLPR utility
or the folder to spool, you cannot delete the folder. Delete any unwanted files before
running Uninstall OkiLPR Utility.
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MICROSOFT WINDOWS

OVERVIEW

This chapter provides guidelines on how to print over the network from various Microsoft
Windows platforms. There are numerous ways of printing from Windows and the exact set-
up will vary depending upon your environment. There are also numerous versions of
Windows, which can be configured as either a client, server or both.

Although there are many variants of Windows, the principles of network printing are the
same. Microsoft provides on-line help with all of their operating systems and this is a good
reference point for the exact details of each configuration option within Windows.

NOTE
Not all utilities, features or protocols are supported by every operating
system. Please check with your support website for latest information.

INSTALLING A NETWORK PRINTER

There are two ways to set up a Network Printer:
> Install automatically, using the Oki Driver Installer

> Install it yourself using the Add Printer Wizard

USING THE OKI DRIVER INSTALLER

The Oki Driver Installer program searches for compatible printers on the Network, then
installs and configures the printer drivers with the correct port settings automatically.

Using the OKki Driver Installer program, you can install to the following connected printer
types:

1. Locally connected printers
> USB port
= Parallel port

2. Networked printers

> Directly connected (peer-to-peer) printers via TCP/IP.
The Microsoft standard TCP/IP is installed and configured to use Port 9100 with
the printer’s IP address.

> Printers not directly connected, but shared via a PC (Client Server)

Why use the Oki driver installer?
> Automatically discovers printers on the Network (TCP/IP)
> Installs driver and correctly assigns the appropriate port and IP address
> Allows easy configuration and sharing of the printer with other Network users

> Automatically configures the printer driver with the appropriate hardware device
options such as storage device, duplex unit, additional paper tray, etc. (via the
Oki Network Extension software)
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USING THE ADD PRINTER WIZARD

Method summary:

The following table shows the different ways to connect to the printer (port types).

WINDOWS WINDOWS WINDOWS VISTA/
2000 XP SERVER 2003/
SERVER 2008/7
Windows Rally NO NO YES
Windows standard YES YES YES
TCP/IP
Oki LPR YES YES NO
IPP YES YES YES
NetBEUI YES YES NO

About the different methods
Windows Rally

Windows Rally is an automated “Plug-n-Play” type utility that allows users to discover and
configure network devices effortlessly.

Windows standard TCP/IP port

The standard TCP/IP port simplifies connecting to remote pinters using the TCP/IP protocol.
A computer that acts as a print server must run the TCP/IP protocol in order to print.

Can be configured to use either LPR or RAW (e.g. Port9100).
OKIiLPR
Used to connect your printer over TCP/IP using an LPR port.

OKILPR also includes useful tools enabling you to download PS and PRN files directly to your
printer and automatically redirect jobs to other printers on the network.

IPP

The IPP (Internet Printing Protocol) defines a standard protocol for printing as well as
managing print jobs, media, resolution etc.

NetBEUI

NetBEUI (NetBios Extended User Interface) is a protocol that was designed for use in small
workgroups or LANs. Within Windows NetBEUI is used for file and printer sharing between
computers. It provides a simple method of printing, but it does have limitations, and is not
as robust as TCP/IP or IPX. Typically it is employed in small business or home networks.

CONFIGURING THE NETWORK PRINTER IP ADDRESS

Use the Standard Set-up Utility to configure the IP Address, Subnet Mask and Gateway.

NOTES
It will not be necessary for printers connected to a network using DCHP to use
this setup method.

Some steps may not display depending on the network protocols installed.

1. Ensure that the printer is switched on and connected to the network.
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10.
11.
12.

13.
14.

Insert the CD-ROM/DVD-ROM into the CD-ROM/DVD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click setup.exe (in the root
directory) on the CD-ROM/DVD-ROM.

Select the appropriate language.

If you wish to proceed, click to agree to the User Licence Agreement.
Navigate to and select Network Card Setup.

Select the “Install” link.

Select the appropriate language.

Select Oki Device Quick Setup and follow the on-screen instructions.

Select the appropriate network card, using the Ethernet address to identify it, and
click Next.

The Ethernet address (MAC Address) is displayed on the configuration map, refer to
“Configuration settings” on page 7.

Using TCP/IP protocol

When using Ipr in UNIX and other TCP/IP environments, please select Yes. To use in
a TCP/IP environment, an IP address should be assigned to the Ethernet card.

If Yes has been selected and TCP/IP is the only working protocol and the IP address
has not already been assigned, you can either obtain an IP address automatically or
assign an IP address.

When Obtain an IP address automatically is selected, the device IP address will
be automatically assigned by the DHCP server. In an environment without a DHCP
server, please assign the IP address manually.

If you are manually assigning an IP address, you need to enter:
> An IP address

> Subnet mask

> Gateway address

Click Next.

Select your preferred protocol.

When the settings are correct, click Execute. The new settings are transmitted to
the network card but it still operates with pre-transmission settings.

Click Finish to validate the new settings.

Switch the printer off for 15 seconds and on again.

Now that both Windows and the printer have been configured to use TCP/IP, the next step
is to configure Windows to print to the network printer.
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UNIX

NOTE
Not all utilities are supported by every operating system. Please check with
your support website for latest information.

OVERVIEW

The printer supports many protocols such as LPD, FTP, TELNET, SNMP and IPP, and works
within the UNIX environment.

To use the network card within the UNIX environment, the following steps are required:

CONFIGURATION

NETWORK INTERFACE CARD SETTING

The first step in installing the network card under UNIX is to set up the IP address, Subnet
Mask and Gateway. This section explains one way to set them up from a UNIX workstation.

> The network addresses used in this manual are shown as examples only. Network
addresses used in your installation must be generated for your own network.

> Log in as root to change the configuration of the printer.

> If an incorrect IP address, Subnet Mask or Gateway is entered, the network may go
down or other damage may occur. Check the address with your network manager.

The following explanation uses Sun Solaris 2.8 (Solaris 8) as an example. The actual
commands may differ between versions of UNIX, so refer to the workstation manuals for
more information.

NOTE
If you do not have superuser rights, the network manger should conduct the
configuration.

1. Log in as root to the workstation.

If the printer does not have an IP address already assigned, use the arp command to
set a temporary IP address.

Example: for IP address 192.68.20.127 and network card address
00:80:87:01:00:D2

# arp -s 192.168.20.127 00:80:87:01:00:D2 temp

The Ethernet address (MAC address) 00:80:87:01:00:D2 in the above example can be
determined from the network card self-diagnostic test.

3. Use the ping command to confirm the connection with the network interface card.
Example: for IP address 192.168.20.127
# ping 192.168.20.127

If there is no reply, there is a problem with the configuration of the IP address (the
IP address has already been set manually or dynamically), or with the network. Reset
the network interface card settings to default and try to set a temporary IP address.

If you still have the problem after resetting the network interface card, consult the
network manager.
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4. Login to the network interface card using TELNET.
Example: Logging in to IP address 192.168.20.127

#telnet 192.168.20.127
Trying 192.168.20.127
Connected to 192.168.20.127
Escape character is ‘7’
EthernetBoard 8100e TELNET server
login: root

‘root’ user needs password to login.
password: <CR>

User ‘root’ logged in.

No. Message Value (level .1)
Setup TCP/ 1IP

Setup SNMP

Setup NetWare

Setup EtherTalk

Setup NetBEUI

Setup printer trap
Setup SMTP (Email)

9 : Maintenance

10 : Setup printer port

11 : Display status

12 : IP Filtering Setup

97 : Network Reset

98 : Set default (Network)
99 : Exit setup

Please select (1- 99)°?

N oUW N

5. Type 1 and press the Enter key. Perform the following settings:

Please select (1- 99)? 1
No. Message Value

1 TCP/ IP protocol : ENABLE

2 IP address : 192.168.20.127

3 Subnet Mask : 255.255.255.0

4 Gateway address : 192.168.20.1
5 RARP protocol : DISABLE

6 DHCP/ BOOTP protocol: DISABLE
7 Auto IP Address : DISABLE

8 : DNS Server (Pri.) : 0.0.0.0

9 : DNS Server (Sec.) : 0.0.0.0
10 : root password : W“WkFkkkxn

11 : Auto Discovery Setup

99 : Back to prior menu

Please select (1- 99)°?

6. Logout from the network interface card. Turn the printer off for about 15 seconds
and on again to validate the settings.

LPD printing

Line Printer Daemon (LPD) is the most common protocol for printing with TCP/IP to
a network printer. Refer to the workstation’s manual for details of Ipr and Ip
commands. The following explanation in this section uses the printing of print file
test.prn with printer name Myprinter_lp as an example.
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Logical printers

%

>

The printer’'s network interface includes three logical printers.
Ip must be used for printing a file created using the printer driver.
sjis must be used for printing a text file of Shift JIS Kanji code.

euc must be used for the printing a text file of the EUC Kanji code.

LOGICAL PRINTER PRINTER FUNCTION

Ip For direct output
sjis For Shift JIS Kanji converted output
euc For EUC Kanji converted output

sjis and euc function only as PostScript printers.

BSD-based UNIX

Print using the Ipr command.

# lpr Pmyprn lp test.prn

If the Iprm command is used, the print job is cancelled.
Example: To delete a print job (Job ID 123) on the myprn_Ip
# lprm Pmyprn lp 123

Verify the printer status using the Ipg command.

The result of Ipg may not be displayed correctly depending on UNIX operating system
specification.

# lprm myprn lp

System V-based UNIX

Print using the Ip command.

# Ip —d myprn_Ip_Ip test._prn

Delete a print job using cancel command.

Example: To delete a print job (Job ID 456) in the myprn_Ip
# cancel myprn 1lp -456

Verify the printer status using the Ipstat command.

# lpstat

The result of Ipstat may not be displayed correctly depending on UNIX operating
system specification (e.g. Solaris 2.x).

FTP printing

FTP (File Transfer Protocol) is used for transferring a file with TCP/IP. If the print data
is sent to a logical printer via FTP, it is printed.

Refer to the workstation’s manual for details of the ftp command. The following
explanation uses print file test.prn with printer name myprn_Ip as an example.
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LOGICAL DIRECTORIES

The printer’s network interface includes three logical directories.

> Ip must be used for printing a file created using the printer driver.
> sjis must be used for printing a text file of Shift JIS Kanji code.

> euc must be used for the printing a text file of the EUC Kanji code

LOGICAL DIRECTORY PRINTER FUNCTION

Ip For direct output
sjis For Shift JIS Kanji converted output
euc For EUC Kanji converted output

> jis and euc function only as PostScript printers.
> You can not send data to the root directory.
1. Log in to the network interface card.

When printing with ftp, use any values for name and password. However, if the user
name is root, the password set under TELNET or the utility is required. See the
appropriate section for details.

Example: Logging in with host name myprn (or IP address 192.168.20.127).

# ftp myprn (or ftp 192.168.20.127)
Connected to myprn

220 EthernetBoard 8100e Ver 01.50 FTP Server
Name (myprn:<none>) : root

331 Password required.

Password:<CR>

230 User Logged in

ftp>

The network card logical directory structure is hierarchical. Move to the logical
directory; it is not possible to output print data to the root directory.

2. Move to the preferable logical directory using the cd command.

Example: moving to the Ip directory and confirming the current directory.

ftp> cd /1lp

250 Command OK.

ftp> pwd

257 " /1lp” is current directory
ftp>

3. Configure the transfer mode.

There are two types of transfer mode: BINARY mode, in which the file content is
output as it is and ASCII mode, which converts the LF code to the CR+LF code. If a
binary file converted by the printer driver is transferred, the transfer mode has to be
BINARY mode.

Example: Changing transfer mode to binary mode and verifying the current mode:

ftp> type binary
200 Type set to I.

ftp> type
Using binary mode to transfer files.
ftp>
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Transfer the print data to the network card using the put command. Two methods of
file transfer using the put command are available.

Example: Transferring print data test.prn

ftp> put test.prn

Example: Transferring print data specified by absolute path/users/test/test.prn
ftp> put /users/test/test.prn /lp

Logout from the network card using the quit command.

ftp> quit

Three states can be verified using the quote command stat: the IP address, login user
name and transfer mode. In addition, printer status can be verified by specifying the
directory after the stat (Ip, sjis, euc).

Example: Displaying network card status

ftp> quote stat

211-FTP server status:

Connected to: 192.168.20.10.000.00
User logged in: root

Transfer type: BINARY

Data connection: Closed.

211 End of status.

ftp>

Example: Displaying the network card status (directory name: Ip)
ftp> quote stat /lp

211-FTP directory status:

Ready

211 End of status
ftp>
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MAC OS X

OVERVIEW

This section of the guide is for administrators and it should be read in conjunction with the
relevant Mac OS X manual. Please ensure that your Mac has the latest OS X updates
installed.

To get the best results from your printer, install the Postscript Printer Description (PPD) file
supplied with your printer and use this to customise the Apple PostScript driver that is built-
in to the OS X. Features provided by the PPD file include:

> Supported paper types
Paper trays

>
> Printer resolution
>

Printer colour matching

NOTE
> The PPD file must be installed using the Oki Driver Installer to ensure that
all essential files are copied.

> Not all utilities, features or protocols are supported by every operating
system. Please check with your support website for latest information.

SETTING UP A NETWORK PRINTER

1. If the printer does not already have an IP address, use the Printer Setup Utility to
assign an IP address. See “The printer setup utility interface” on page 44.

To do this, you will need to know the printer's MAC address. This can be found on the
print server's network summary printout. See “Configuration settings” on page 7.

2. Install the printer driver software. This copies the printer driver files to the correct
location on your Mac OS X system.

3. Make a connection to the printer by USB, TCP/IP, Rendezvous or AppleTalk. See
“Connecting to your printer” on page 50.

4. If required, enable hardware device options such as additional paper trays, duplex
unit or storage device. See “Configuring printer hardware options” on page 54.

PRINTER SETUP UTILITY

The Printer Setup Utility is a powerful MacOS-based utility for configuring all print server
functions using a graphical user interface.

INSTALLING THE PRINTER SETUP UTILITY
1. Insert the CD/DVD into the CD-ROM/DVD-ROM drive.
2. Navigate to the Utilities folder.
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3. Open the Printer Setup Utility folder and double-click Installer.

® O ® [ Printer Setup Utility o
> 3 items, Zerc KB available
=
Installer Info

NI

4. Select the destination directory, then click Next.

& O 7 Installer

If the folder destination for the installation is
changed, click on [Reference] and select the

OKI folder.

T L TR

—Folder Destination for Installation
Tiger:Users: 0Kl Tools

Okl Network Sousomns

b (Reorencer )
< Back G—gﬂﬁ)ﬁﬁ—%" ‘Nex C Cancal )

5. Ensure the Yes option is selected to activate the utility, then click Finish.

& O 7 Installer

Setup Utility Installation is complete.

OKI

PRINTING SOLLTIONS

Mext, you can activate the Setup Utility.

Do you want to activate the Setup Utility?

) Yes
() No
Okl Network Soktions
[ fora Global Society
( < Back ] (——————Fhﬁh'v———% [ Cancel J
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THE PRINTER SETUP UTILITY INTERFACE
The Printer Setup Utility auto-discovers Oki compatible network cards.

1. Select the correct printer NIC to configure, click Setup menu then choose OKkKi
Device Setup.

® O 7 Setup Utility

Ao LB s

Model Name | Ethernet Address IP Address
OkiLAM B300e 00:80:87:B4:58:FD

OkiLAN 84509
OKkiLAM 65002

8.207.59

101

OKILAM 84508 10.18.207.108

OkiLAM 66009 00:80:87:06:00:04 10.18.207.112

OKkILAM 65002 00:80:87:D4:32:F4 10.18.207.87

OKIiLAM 84502 00:80:87.74:57:26 10.18.207 .55

OkiLAM 83002 00:80:87:D4:C2:39 10.18.207.96

OKIiLAM 84509 00:80:87:AB:54:F3 10.18.207.50

OKILAN 84502 00:80:87.CB:0E:AB 10.18.207 .62

10 Oki Devices are found in the netwod. |/

2. At the prompt, enter the Admin password.

Password

Input Password : |******1 |

] Guest user (read only)

4 Cancel ) (—BI(——)

NOTE

The default admin password is the last six digits of the MAC Address, minus
any punctuation marks. e.g., for a MAC (Ethernet) Address of
00:80:87:A4:55:79, the password would be A45579.

3. Select the TCP/IP tab and assign your printer’s IP address.
4. Click Apply.

OkiLAN 8450g(10.18.207.142)
General | TCP/IP | Metware | EtherTalk | MetBEUI | SHMP

™ Use TCP/IP Protocol
[T Use DHCP/BOOTP

IP Address [Lo:18.:207.142 |
Subnet Mask [255.255.255.0 |
Default Gateway [10.18.207.1 |

"lUse IPv6 Function

l Initialize ) [§ Cancel ) E—hly—)
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MENU OPTIONS

Discover Printers

Locates and lists all printers in your network which have an Oki compatible network
card installed.

Printer status monitor

Displays the current status of the printer.

Printer NIC card summary/System status

Displays the network card summary details.

Change settings/Oki device setup
Use this to configure the network card settings (requires Admin password).

General Tab

OkiLAN 84509(10.18.207.142)
[ General [_TEPAP | MWetware | EtherTalk | NetSEUI | SNHP

admin Password |k}§t»t

Change...

Initialize ) [ Cancel 3 ( Apply )

The General tab allows you to change the admin password.
1. Click Change.

2. Enter the current value, then enter the new value and re-enter it under Confirm ....

NOTE

The default admin password is the last six digits of the MAC Address, minus
any punctuation marks. e.g., for a MAC (Ethernet) Address of
00:80:87:A4:55:79, the password would be A45579.

3. Click OK.
4. Click Apply.
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TCP/IP Tab

OKkILAN 84509(10.18.207.142)

[ General | TCP/IP | Metware | EtherTalk | NetBEUI | SNHP

[ Use TCP/IP Protocol
] Use DHCP/BOOTP

IP Address
Subnet Mask

Default Gateway

[ Use IPv6 Function

[to.18.207.142 |

[255.255.255.0 |

[10.18.207.1 |

C

) ( Cancel ) m

ITEM COMMENTS

Use TCP/IP Protocol

Enable/disable TCP/IP protocol.

Use DHCP/BOOTP

Click to select this item if the IP address, subnet mask,
default gateway and IP addresses for DNS primary
server and secondary servers are retrieved from the
DHCP or BOOTP server.

IP Address

Set the IP address of the selected network interface
card.

Subnet Mask

Set the subnet mask of the selected network interface
card.

Default Gateway

Set the default gateway of the selected network
interface card.

Use IPv6 Function

Use to enable/disable IPv6.

Netware Tab

ITEM COMMENTS

Use NetWare Protocol

Enable/disable NetWare protocol.

Print Server Name

Set a Print Server name.

Frame Type

Set the primary NetWare frame type.

Operation Mode

Select the NetWare mode:
PSERVER Mode (the default)
RPRINTER Mode

Bindery Setup

Configure Bindery mode items, including:

File Server to be
connected.

Specify up to 8 file
servers to connect.

Password.

Set a password for the
Print Server.

Job Polling Time

Set the print job polling
interval in seconds.

NDS Setup
was created.

Set the NDS Tree and Context where the Print Server

Printer Name

Set the NetWare printer object name.
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EtherTalk Tab

DOKILAN 84509(10.18.207.142)

W Use EtherTalk Protocol

Printer Name “ |

Zone Name ‘“‘ |

C Initialize ) C Cancel ) @ )

ITEM COMMENTS

Use EtherTalk Enable/disable EtherTalk protocol.

Protocol

Printer Name Set the EtherTalk Printer object name.

Zone Name Set the name of the zone to which the print server
belongs.

NetBEUI Tab
OKILAN 84509(10.18.207.142)
AR WFtWare |TEtherTalk | NetBEUl [CENME

¥ Use NetBEUI Protacol

Short Printer Name ‘ }

Workgroup [Prineserver |

Comment [ErhernerBoard CKILAN 8450g ]

C Initialize ) C Cancel ) @ )

ITEM COMMENTS

Use NetBEUI Enable/disable NetBEUI protocol.

Protocol

Short Printer Name Set a name for the print server.

Workgroup Set a name for the work group to which the print server
belongs.

Comment Set the comments for the print server.

Mac OS X = 47



SNMP Tab

DOKILAN 84509(10.18.207.142).

‘MIB-I1l Parameters
. SysContact |
SysName [@K\g |
SysLocation \ |
C ) (L caneel ) @ Ame )
ITEM COMMENTS
SysContact Set the printer manager name.
SysName Set the printer model name.
SyslLocation Set the location where the printer is installed.

Open web browser/Configuration via HTTP
Displays the printer web page.

Change utility preferences/Environment setup

Use this to configure the utility preferences for broadcast addresses for TCP/IP
protocol and Time Out.

TCP/IP Tab

Environment Setup

TCRAP I Timeout

Set Broadcast Address

| € Add )

Delete

( Cancel ) G—H

ITEM COMMENTS

Set Broadcast Set broadcast addresses that are used to search OKi

Address network interface cards using the TCP/IP protocol.

Add Click Add to add the address to the list in the box.

Delete Select an address in the box, then click Delete to remove
it.
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Timeout Tab

Environment Setup
[TEFAIP | Timeout |

[ Set Timeout

Printer search setting

Polling Interval (20-180 seconds)

Data Send/Receive

Time Outs (1-60 seconds)
Retys -

( Cancel ) E—H

ITEM COMMENTS

Set Timeout: Printer Search Every (20-180sec)
Search Set the response waiting time from the network card in
seconds. Default is 30 seconds.

Set Timeout: Time Outs (1-60sec)

Data Send/Receive Set time out between AdminManager and the network
interface card in seconds. Default is 5 seconds.
Retry (1-5)

Sets how many times AdminManager will retry to
transmit/receive data to/from the network interface
card. Default is 3 retries.
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CONNECTING TO YOUR PRINTER

SNow LEOPARD (10.6) AND LEOPARD (10.5)

USB
1. Choose Apple Menu > System Preferences > Print & Fax.
2. If the printer is already in the list of printers, click “-” to remove it.
NOTE
This is necessary as Leopard may not be using the correct printer driver files.
3. Click “+” to add a new printer.
4. Ensure the Default tab is selected and select your printer from the list.
= Your printer is displayed as type USB in the list of available printers.
> Ensure that the Print Using: selection matches your printer. If Generic
PostScript Printer is displayed, select a driver that matches.
5. Click Add.
6. Click Configure... and ensure the hardware options displayed match your printer.
NOTE
Hardware options are not configured automatically.
The printer is added to the list of printers.
7. Restart your computer.
Bonjour
1. Choose Apple Menu > System Preferences > Print & Fax.
2.  Click “+7,
3. Select your printer model from the Default Browser.
4. Click Add....
5. Depending on the connection type, you may be prompted to configure any additional

printer hardware options. If your printer has options such as a storage device or
second tray, switch on the relevant options.

AppleTalk (Leopard only)

o rwNPE

NOTE
AppleTalk is not supported in Snow Leopard.

Choose Apple Menu = System Preferences > Print & Fax.
Click “+.

Select your printer model from the Default Browser.

Click Add....

Depending on the connection type, you may be prompted to configure any additional
printer hardware options. If your printer has options such as a storage device or
second tray, switch on the relevant options.
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TCP/1P Connection
1. Choose Apple Menu > System Preferences > Print & Fax.
Click “+.

3. Click the IP Printer button.
4. From the Protocol menu, choose Line Printer Daemon — LPD.
5. Enter the printer's IP address in Address.

To find the printer's IP address, you can print a configuration page from the printer's
operator panel. Refer to “Configuration settings” on page 7.

6. Check the correct PPD file for your printer is selected in the Print Using menu.
7. Click Add.

8. You will be prompted to configure any additional printer hardware options. If your
printer has options such as a storage device or second tray, switch on the relevant
options.

TIGER (10.4)

Bonjour, AppleTalk or USB
1. Launch Printer Setup Utility

This is located in the Applications > Utilities folder.
2. Click Add....

3. Select your printer model from the Default Browser.

6 O O Printer Browser (=]

AppleTalk

Name:

Location

Print Using:

? More Printers

4. Click Add.

Depending on the connection type, you may be prompted to configure any additional
printer hardware options. If your printer has options such as a hard disk or second
tray, switch on the relevant options.

5. Quit Printer Setup Utility.

TCP/IP Connection
1. Launch Printer Setup Utility
This is located in the Applications > Utilities folder.
2. Click Add....
3. Click the IP Printer button.

4. From the Protocol menu, choose Line Printer Daemon — LPD.
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5.

9.

10.

Enter the printer’s IP address in Address.

® O O Printer Browser =)
A L

—
Default Browser  IP Printer Search

Protocol: | Line Printer Daemon - LPD |

Address: )

Enter host name or IP address,

Queue -

Leave blank for default queue

Name
Location:

Print Using: 4

7 More Printers

To find the printer’'s IP address, you can print a configuration page from the printer
operator panel. Refer to “Configuration settings” on page 7.

Check the correct PPD file for your printer is selected in the Print Using menu.
Click Add....

You will be prompted to configure any additional printer hardware options. If your
printer has options such as a hard disk or second tray, switch on the relevant
options.

Click Continue.

Quit Printer Setup Utility.

PANTHER (10.3) AND JAGUAR (10.2)

Rendezvous

NOTE
= This utility is called Print Center on Mac OS X 10.2.x.

= If your printer is already listed, your Mac may already have discovered the
printer before you installed the Oki software. In this case, the printer may
be using the incorrect PPD file or may not have the correct hardware
options configured. You should delete the printer, quit Printer Setup
utility, and re-launch the utility before continuing.

If you have not already done so, run the Oki software installer before following the steps
below.

1.

o 0 M wN

Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

Click Add....

From the pop-up menu, choose Rendezvous.

Select the printer you wish to connect to.

Click Add.

Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

After adding the printer, you should configure printer hardware options. Refer to
“Configuring printer hardware options” on page 54.

Mac OS X = 52



IP CONNECTION

If you have not already done so, run the Oki software installer before following the steps
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

NOTE
= This utility is called Print Center on Mac OS X 10.2.x.

> If your printer is already listed, your Mac may already have discovered the
printer before you installed the Oki software. In this case, the printer may
be using the incorrect PPD file or may not have the correct hardware
options configured. You should delete the printer, quit Printer Setup
Utility, and re-launch the utility before continuing.

Click Add....
Click the pop-up menu and choose IP Printing.
Click the Printer Type menu and choose LPD/LPR.

o M w N

Enter the printer's IP address.

To find the printer’s IP address, you can print a configuration page from the printer’s
operator panel. Refer to the User’s Guide for details.

The Configuration pages are printed. The printer’s IP address is shown under the
Network section on the left-hand side of the first sheet.

6. Enter the queue name. If you do not know the queue name, leave it as Use Default
Queue on Server.

7. Click the pop-up menu and choose your printer model.
8. Click Add.
9. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

After adding the printer, you should configure printer hardware options. Refer to
“Configuring printer hardware options” on page 54.

AppleTalk connection

If you have not already done so, run the Oki software installer before following the steps
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

NOTE
This utility is called Print Center on Mac OS X 10.2.x.

Click Add....

From the pop-up menu, choose AppleTalk.

Select the printer you wish to connect to.

Click Add.

Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

o 0 M wN
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USB connection

If you have not already done so, run the Oki software installer before following the steps
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

NOTE
> This utility is called Print Center on Mac OS X 10.2.x.

= If your printer is already listed, your Mac may already have discovered the
printer before you installed the Oki software. In this case, the printer may
be using the incorrect PPD file or may not have the correct hardware
options configured. You should delete the printer, quit Printer Setup
Utility, and re-launch the utility before continuing.

Click Add Printer....

From the pop-up menu, choose USB.

Choose a printer to connect to.

Click Add.

Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

o 0k~ wN

CONFIGURING PRINTER HARDWARE OPTIONS

NOTE
Applies to IP and Rendezvous network connections only.

If you have added additional hardware, for example additional paper trays, to your printer
these must be enabled in the printer driver.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

NOTE
This utility is called Print Center on Mac OS X 10.2.x.

Ensure that your printer model is selected.
2. Click the Printers menu, and choose Show Info.
From the popup menu, select Installable Options.

4. Select any options appropriate to your hardware, and click Apply Changes.

PRINTING THE CONFIGURATION PAGE

The printer’s configuration page reports information that is required for Macintosh
configuration. Refer to “Configuration settings” on page 7 for details on how to print a
configuration page.

The first six characters of the Ethernet address are the same for all network cards. The last
six characters of the Ethernet address are unique to each card.

NOTE
Not all utilities are supported by every operating system. Please check with
your support website for latest information.

Mac OS X = 54



TROUBLESHOOTING

The network addresses used in this manual are shown for example only. Network addresses
used in your installation must be generated from your own network.

SELF-DIAGNOSTIC TEST

PRINTER DOES NOT PRINT

Ensure the printer emulation is set to PS or Automatic.

NG IS PRINTED IN THE SELF-DIAGNOSTIC TEST OR FLASH ROM CHECK REGISTERS NG
Turn the printer off for 15 seconds and then on again.

Press the reset button on the rear panel, close to the network interface to re-initialize it.

TCP/IP

COMPUTER CANNOT FIND THE NETWORK INTERFACE CARD
> Turn the printer off for 15 seconds and then on again.
Confirm the network interface is enabled on the printer.

Check there is a response to the PING command.

Vv V V

Check that the network cable is correctly connected and that the green LED close to
the printer’s network interface is lit. If not, change the cable and try again.

Run the Self-diagnostic test.
Check the IP Address, Subnet Mask and Gateway are correct.
Check that the TCP/IP protocol is set to Enable.

Reset the network interface card to factory default settings.

vV V. V VvV V

If DHCP, BOOTP and RARP are not used, ensure they have been set to Disable.

CANNOT PRINT WITH LPR AND FTP

Turn the printer off for 15 seconds and then on again.

Check there is a response to the ping command.

Check the network cable is correctly connected.

Change the cable and try again.

Check the host name and IP address are configured in the workstation.

Check the printer port name is configured in the workstation.

vV V V. V V V V

There are three port names: Ip, euc and sjis. Use Ip by default as euc and sjis are
specific to PostScript printers.

INCORRECT USER NAME ON THE BANNER PAGE

If printing with Ipr, the user name printed is unknown and the filename printed is the Spool
file name.

If printing with FTP, the user name printed is the user name entered during FTP login and
the file name printed is the transmitted file name. If the print directory name is indicated
in the put command, the file name is not printed. The printer name printed is the logical
directory name.
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WEB BROWSER

To prevent your web browser caching the printer web pages, carryout the following steps
as appropriate for your web browser.

NOTE

Keeping this setting enabled all the time may slow down web browsing. You
may want to revert back to the browser default setting once you have finished
using the printer web page.

MICROSOFT INTERNET EXPLORER
1. Select Tools > Internet Options.
2. Select the General tab and, in Temporary Internet files, click Settings.

3. Under Check for newer versions of stored pages, select Every visit to the
page.

4. Click OK.

E 2 [x]|

‘ Check for newer versions of stored pages:
e
& (%) Every visit ko the page

{:} Every time you start Inkernet Explarer

() Automatically

{:} Mewer

Temporary Internet files Folder

Current location:  CDocuments and SettingstkravitLocal
Settingst Temparary Internet Files!,

Amount of disk space to use:

J 1159 = | mB
[ Move Folder, .. ] [ View Files. .. ] [ YWiemw Objects, .. ]
[ K ] [ Cancel ]
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MOZILLA FIREFOX

P W N

In the Firefox address bar, type about:config.

In the Filter field, type frequency.

Double click on the entry browser.cache.check doc_frequency.

Change the Value to 1.

> 0: Check once per browser session

> 1: Check every time | view the page

> 2: Never check (always use cached page)

> 3 (default): Check when the page is out of date (automatically determined)
Click Ok.

©) about:config - Mozilla Firefox

File  Edit Miew History Bookmarks Tools  Help

= c (g I: |j about:config T-? M

Filker: | frequency

Preference Mame T Status Tvpe Yalue
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OKI EUROPE LIMITED
Blays House

Wick Road

Egham

Surrey TW20 OH])
United Kingdom

Tel: +44(0) 2082192190
Fax: +44(0) 208 219 2199
WWW.OKIPRINTINGSOLUTIONS.COM
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